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Everything You Wanted to Know about Using the Mac App Store (For Now)
by SHARON ZARDETTO

There’s a new Mac App Store just around the 
corner, in macOS 10.14 Mojave, and thanks to 
changes in Apple’s policies, it’s wooing back 
some beloved Apple developers like Bare Bones 
Software and Panic (see “The Big News about 
macOS 10.14 Mojave Is Dark,” 4 June 2018).

For the next several months, though, you’ll 
still be shopping in the current Mac App Store, 
with the current App Store app, whose features 
aren’t always obvious and which has a few 
glitches. The utility that you bought in 2010 
which hasn’t worked in years, for instance, doesn’t have to haunt your Purchased list forever. You can 
avoid pig-in-a-poke purchases by checking an item’s Info page, which includes reviews by users. You 
don’t have to supply your password for every single item you buy when you’re on a shopping spree. And 
if you experience an interrupted download, there are various ways to restart it.

Set App Store Password Preferences
Before you go shopping, take a trip to the App Store preferences to set your shopping password 

preferences. If you’re in the App 
Store app, choose App Store > 
Preferences or open System 
Preferences > App Store. Either 
way, you’ll end up in the App 
Store pane of System Preferences. 
At the bottom of the pane, set 
the two items under Password 
Settings:

• Purchases and In-app 
Purchases: The Always 
R e q u i r e o p t i o n i s 
self-explanatory. Require 
After 15 Minutes lets you 
click a few Buy or Get 
buttons in a row without 
repeated demands for your 
password. But pay attention 
to the second part of the label: Purchases and In-app Purchases. Although I’m sure no one has ever 
mistakenly clicked or tapped an option that makes an in-app purchase, you might be the first, and 
reentering your password is a small price to pay for avoiding other small prices. (And if you’re sharing 
your computer with a child, it’s even more important to keep this at Always Require so they can’t 
make additional in-app purchases after you’ve allowed the first one.)

A Publication of the Silicon Mountain Macintosh User Group

Continued on page 4

Next Meeting: 
Monday 

July
9th

https://tidbits.com/2018/06/04/the-big-news-about-macos-10-14-mojave-is-dark/
https://tidbits.com/2018/06/04/the-big-news-about-macos-10-14-mojave-is-dark/
https://tidbits.com/2018/06/04/the-big-news-about-macos-10-14-mojave-is-dark/
https://tidbits.com/2018/06/04/the-big-news-about-macos-10-14-mojave-is-dark/
https://en.wikipedia.org/wiki/Pig_in_a_poke
https://en.wikipedia.org/wiki/Pig_in_a_poke
https://tidbits.com/uploads/2018/06/Password-settings.jpg
https://tidbits.com/uploads/2018/06/Password-settings.jpg


SMMUG Info 2
SIG NEWS

The Saturday SMMUG Special Interest Group 
(SIG) will meet from 10:00 AM to 12:00 Noon, 
Saturday, July 14, 2017, in the Fire Station 18’s 
meeting room at: 6830 Hadler View (a map is 
located at the end of this NL). The meeting will be 
divided in to two parts.

The First part starting at 10:00 we will focus on 
the Photo’s editing. Starting at 11:00 will focus on 
iOS, helping everyone become both comfortable 
and proficient with their iPhone, iPad, and iPod 
mobile devices. 

All are invited, but new users are especially 
encouraged to attend this free meeting. Bring your 
tips and tricks, questions and suggestions. 

For more information about Special Interest 
Groups (SIGs), go to the SMMUG website.

Scan this QR code to be taken to our 
SMMUG web site

ADVERTISING
You can advertise your business or service 
through the Silicon Summit.

RATES 
Per inch   $10
Quarter page   $15 
Half page   $25 
Full page   $50 
Insert                  $15

A 10% discount is applied for ads that 
run two or more months, except for 

inserts.

Sponsor ing Membersh ips a re a l so 
available to merchants who want to see 
their business name and address listed on 
the front page. Sponsoring Memberships 
are $100 for one year.

MEETING DATES
 

Our regular monthly meetings are on the second 
Monday of every month. Upcoming meeting 
dates are as follows:

July 9, 2018  
August 13, 2018  

September 10, 2018 
October 8, 2018  

November12, 2018  
December 10, 2018

                                                                              
MISSED AN ISSUE?

You can find the previous issues of the 
Silicon Summit posted in PDF format at 
the SMMUG website.

THIS MONTH AT SMMUG

July 9, 2018
6:00 Q&A Session
6:45 Networking Break
7:00 Passwords & Security by Rich Voelker
8:00 Adjourn
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Announcements

Advanced notice
This is a quick reminder that in August we will have our 
annual pizza party at Fargo’s.

June’s Presentation:
SMMUG would like to thank Bob “Dr. Mac” LeVitus 
for his presentation to our club last month.

July’s Presentation:
Rich Voelker from Voelker Research will 
talk to the club about Passwords and 
Security.

July’s Door Prizes:
Akvis AirBrush (Software)
$10 iTunes
iPhone 6 case
32GB ixpand Mini Flash Drive by SanDisk

Club News
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• Free Downloads: It’s obvious what Require Password does, but the same can’t be said of the Save Password option. You can rightly assume it’s 

the poorly phrased opposite: once you’ve entered your password for anything else, a free app doesn’t need your password to be downloaded. 
(Signing in to the App Store at the beginning of a shopping session counts as entering your password.)

If you work on more than one Mac using the same Apple ID, you may also want to select Automatically Download Apps Purchased on Other 
Mac Computers in this preference pane. (Note that this says “automatically”; you can always manually download specific apps you’ve purchased on 
one Mac to another one linked to your Apple ID.)

Buy/Install Basics
Now it’s time to go shopping: launch the App Store app 

(conveniently available by choosing Apple > App Store). If necessary, 
sign in with Store > Sign In. Use the Search field if you know what 
you’re looking for; click the Featured, Top Charts, or Categories button 
to browse. When you find what you want, click the item’s price, which 
changes to Buy App; click elsewhere in the window to revert to the price 
if you change your mind. Freebies have a Get button that changes to 
Install App when clicked.

If you want to know more about an app before you buy, click its 
name to go to its Info page, which not only has further information but 

also displays reviews and ratings from users. You can use the Buy or Get button from there or move back to the previous screen with a click of the 
Back (<) button or by choosing Store > Back.

The installation process of a downloaded app is nearly invisible. An installer file downloads, runs, and courteously erases itself. The app takes up 
residence in your Applications folder, and its icon appears in your Dock and Launcher screen.

Purge the Purchased List
Your App Store Purchased list (click the Purchased button in the toolbar) is a permanent record of your interactions with the store. My Purchased 

list, like my clothes closet, still includes things I bought in 2011. It also still lists OS X Lion, Mavericks, and Yosemite, as well as various utilities I tried 
out but which were either not what I’d hoped or stopped functioning 
after a system update.

Because your Purchased list is permanent, you can’t delete any 
oldsters. But you can hide them: Control-click anywhere in the 
segment that describes the item, choose Hide Purchase in the pop-up menu, and confirm the decision in the dialog. These hidden items are still part 
of your purchase history—they’re just no longer 
displayed in this list.

Getting your hidden purchases back in the list is 
also a cinch, although it takes more steps. Choose 
Store > View My Account, and then, in the 
Hidden Items section, click Manage. Click the 
Unhide button for any item you want re-listed 
and click Done when you’re, you know, done.

Deal with Mac App Store Problems
Here’s how to deal with the most common 

issues.

You can’t connect to the Mac App Store
This Apple support article describes fixes for several common connection problems, starting with checking your Internet connection (of course, 

if that’s the problem, you won’t be able to read the article). It explains such things as how to check Apple’s Web site status, update your account, and 
check inside normally hidden system-level folders. (It also advises that you should make sure that your “date and time are set correctly for your time 
zone,” so you might want to start by trying that quick potential fix.)

https://tidbits.com/uploads/2018/06/App-Store-back.png
https://tidbits.com/uploads/2018/06/App-Store-back.png
https://tidbits.com/uploads/2018/06/Hide-purchase.png
https://tidbits.com/uploads/2018/06/Hide-purchase.png
https://tidbits.com/uploads/2018/06/Hidden-purchases.png
https://tidbits.com/uploads/2018/06/Hidden-purchases.png
https://support.apple.com/en-us/HT201400
https://support.apple.com/en-us/HT201400
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Clicking Buy doesn’t (or doesn’t seem to) do anything, OR the app seemed to download, but it’s not in the Dock or in your Applications 
folder

Look for it in the Purchased tab in the App Store window; if it’s not in the list, choose Store > Reload Page.
If it appears in the list with a Download or Install button, click the button; you won’t be double-charged. If it has an Open button, check your 

Dock and/or Applications folder (or do a Finder search)—you may have been fooled by a small file with a very short download time.
If it’s not anywhere in the Purchased list, go back to it in the Store and click the Buy button again. (If there’s a Buy button, you weren’t charged for 

it.)

A download was interrupted
Most interrupted downloads pick up where they left off as soon as your Mac re-establishes its Internet connection. You might get a dialog asking if 

you want to resume the download, and sometimes you’ll have to supply your Apple ID again to prove that you’re still you.
No auto-resume or dialog? In the App Store window’s toolbar, click Purchased, find the app in the list, and click its Resume button. If you were on 

a buying spree and clicked to download multiple items, you can check whether any are still in transit or waiting in line by choosing Store > Check for 
Unfinished Downloads.

An app downloaded but didn’t install
If a download seems to go smoothly but the app doesn’t appear in your Dock (or Launchpad screen), go back to the Purchased list and click the 

app’s Install button if it has one.
If the button is Open, the App Store thinks it’s installed, so the problem might be that the installer downloaded but for some reason didn’t 

automatically run. Look in ~/Library/Application Support/App Store/ for an installer file, and launch it with a double-click.

You get “Unknown Error Occurred” when you click Buy
When I wrote about this a few years ago, Apple’s advice was to quit the App Store app, wait at least 10 seconds, and then relaunch it. Why 10 

seconds—practically an eon in computer-cycle time? I don’t know, nor do I know why it’s no longer recommended. But I include it in case you’re 
using an older system and version of the App Store app and it would work for you; it won’t hurt, no matter your situation. Besides, quitting and 
relaunching a misbehaving app, wait or no wait, is the universal first-line palliative.

There’s a warning in red type by an item in the Purchased list
I’ve only ever seen this once, and it was several years ago. I have no idea whether it’s still an issue because I can’t fake a problem that might trigger it. 

If you get a warning right within the Purchased list about a download error (or something else—again, my experience here is limited) for a specific 
item, and you redownload the item and everything is fine but the warning stays, here’s how to get rid of it: Choose Store > View My Account, scroll 
to the bottom of the screen and click the Reset button for Reset All Warnings for Buying and Downloading.

Quick Tips
Here are some tips for working in the App Store app:
• “Reinstall” a macOS app: You see a reference to a Safari update—or Photos, or Mail—and realize that you’re a version behind, but can’t find 

an update for it? That’s because they, like other macOS apps (they’re listed here) are automatically updated when you update the operating 
system.

• Find a macOS installer: You won’t see macOS installers for macOS 10.12 Sierra or later in your Purchased list—unless it’s one that you haven’t 
yet downloaded—but they are available. If you need one, use the search field to find macOS installers, typing macos high sierra, for instance.

• Go to previous “screens” in the App Store: As you browse around for the latest offerings, you can easily move through screens you’ve already 
viewed. Click the Back and Forward buttons at the left of the toolbar, or use Command-[ and Command-] to trigger the commands in the Store 
menu.

• The App Store is checking your Applications folder: Check your Purchased list, and you’ll likely find a variety of buttons for the listed items, 
based on each app’s status: Download, Install, Open, or Update. I always thought the App Store app was merely keeping track of what I had 
done thus far with each item. But, no! Drag an installed app out of your Applications folder, and its button in the Purchased list reverts to Install. 
You may need to choose Store > Reload page to see this effect, but it’s automatically updated when the App Store app is relaunched. Put the app 
back in the Applications folder and its button in the Purchased list goes back to Open (or to Update, if that’s the status). This is equal parts 
convenient and creepy. Presumably, this works only if the item is still available in the Mac App Store, but I haven’t been able to test for that.

• Store credit: Your store credit is displayed under Quick Links next to the Account label when you’re in Featured, Top Charts, or Categories 
view. You can also check it by choosing Store > View My Account, where it’s at the bottom of the screen. Note that it’s the “Apple ID Balance,” 
not the “App Store Balance”: this is the same credit that shows in the iTunes Store and the iBooks Store.

https://support.apple.com/kb/PH25125?locale=en_US
https://support.apple.com/kb/PH25125?locale=en_US
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• Outdated-app icons: On a related note, if an app (from the App Store or elsewhere) can’t run under the macOS version you’ve installed, its 

icon changes to include the slashed-circle international symbol, meaning “This app won’t run under your current system.”

Do you have any tips to share for the Mac App Store? Let us know in the comments. And for bonus points, how many of the above icons can 
you identify?

https://tidbits.com/uploads/2018/06/Outdated-app-icons.png
https://tidbits.com/uploads/2018/06/Outdated-app-icons.png
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

@!!#

http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
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iOS, watchOS, & tvOS 
iOS 12 to Improve 911 Emergency Location Sharing

by JOSH CENTERS
When iOS 12 arrives later this year, 911 operators in the United States will be better able to 

locate you in an emergency thanks to a partnership between Apple and RapidSOS. For 
iPhone users concerned about emergency situations, this new capability may be reason enough 
to upgrade quickly.

Since 80% of 911 emergency assistance calls now come from mobile phones, determining 
their location has become a serious problem for 911 centers. The Federal Communications 
Commission is requiring cellular carriers to “locate callers to within 50 meters at least 80% of 
the time by 2021,” and to meet that goal, Apple launched Hybridized Emergency Location 
(HELO) in 2015. HELO uses a mix of cellular tower signals, GPS data, and nearby Wi-Fi 
access points to identify a caller’s location.

It’s still shockingly difficult for 911 operators to determine the location of a call from a cell phone. A 2015 USA Today report found that the 
chances of 911 getting a fix on your location could be as low as 10% and that the problem was getting worse in many parts of the United States.

Apple’s partnership with RapidSOS will let iOS 12 quickly and securely share HELO local data with 911 centers. The data will be sent 
automatically from your iPhone to the RapidSOS NG911 Clearinghouse. You don’t have to do anything other than dial 911 to transmit your 
location. If the receiving 911 center is set up to use the technology, it will receive your precise location information directly from your iPhone.

With regard to privacy, Apple says that the information “cannot be used for any non-emergency purpose and only the responding 911 center will 
have access to the user’s location during an emergency call.”

The nearby city of Nashville, Tennessee will be one of the first to take advantage of this technology, and the Apple/RapidSOS partnership was 
announced at the 9-1-1 Association industry conference in Nashville.

“This upgrade will save lives by giving our 911 dispatchers, police, firefighters and paramedics the thing they need the most: time,” said Nashville 
mayor David Briley. “Every second counts in a crisis, and I appreciate all the work Apple has done to address this issue.”

Of course, if you live outside the United States, you likely use a different emergency system, but we hope Apple can spread this technology more 
widely.

TipBITS: Make Sure Your iPhone Is Capturing Video
by JOSH CENTERS

It’s surprisingly easy to think you’re recording a video on your iPhone, only to realize later that you didn’t tap the 
record button and totally missed that great moment. Adam Engst and I have both flubbed recordings in this way 
on multiple occasions, and we know from helping our families that we’re not alone. Here’s how to make sure your 
iPhone is recording, so you don’t fail to capture a special video.

You probably know how to record a video on an iPhone, but just in case:
1. Open the Camera app.
2. Enter Video mode by tapping the Video label or swiping the viewfinder.
3. Tap the red record button to begin recording.
It’s simple, to be sure, but the problem is that if you fail to tap just the right spot, you may 

think you’re recording, but nothing is actually happening. (You can also press one of the 
physical volume buttons to start and stop recording, but that’s a different tip!)

  There are three changes to be 
aware of as you think you’ve started 
recording to make sure it’s working, along with one other piece of minimal feedback:
•The record button changes from a large red circle inside a white ring to a stop button, a 
smaller red square inside a white ring. Particularly for those whose eyesight isn’t what it once 
was, it can be difficult to see the difference between the record and stop buttons. A more 
significant change in shape or color would be welcome.
•The bar at the top of the screen that displays flash status, recording time, and resolution and 

https://www.apple.com/newsroom/2018/06/apple-ios-12-securely-and-automatically-shares-emergency-location-with-911/
https://www.apple.com/newsroom/2018/06/apple-ios-12-securely-and-automatically-shares-emergency-location-with-911/
https://rapidsos.com/
https://rapidsos.com/
https://www.usatoday.com/story/news/2015/02/22/cellphone-911-lack-location-data/23570499/
https://www.usatoday.com/story/news/2015/02/22/cellphone-911-lack-location-data/23570499/
https://info.rapidsos.com/blog/bringing-apple-device-location-to-911
https://info.rapidsos.com/blog/bringing-apple-device-location-to-911
https://en.wikipedia.org/wiki/Emergency_telephone_number
https://en.wikipedia.org/wiki/Emergency_telephone_number
https://tidbits.com/uploads/2018/05/Camera-app-before-recording.png
https://tidbits.com/uploads/2018/05/Camera-app-before-recording.png
https://tidbits.com/uploads/2018/05/Camera-app-during-recording.png
https://tidbits.com/uploads/2018/05/Camera-app-during-recording.png
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frame rate shrinks down to show just the timer, which begins counting how long you’ve been recording and adds a flashing red dot. This change 
can also be hard to notice because you have to see the disappearance of interface elements, and the rightmost digit in the timer takes a full second 
to change.

• The labels for different types of video and photo modes disappear, as does the button for switching between the front and back cameras. Plus, 
the well containing the last photo or video is replaced by a white circle you can tap to take a still photo during video recording. Again, these 
changes are sufficiently minimal that they can be easy to miss as you look from your screen to the scene in front of you and back.
• If you’re using an iPhone that supports 3D Touch, you’ll feel a very light simulated click when you tap the record or stop buttons.

Train yourself to watch for these changes and you’ll be a lot more likely to know when the iPhone is (or isn’t) actually recording.

Macs & macOS
Apple Announces Service Program for Butterfly-Switch Keyboards

by JEFF PORTEN
Apple has announced a service program for all MacBook and MacBook Pro laptops with 

butterfly-switch keyboards. The announcement lists every model that’s covered, but the short answer is “every 
Mac laptop to date with a USB-C port,” meaning 12-inch MacBooks since 2015 and MacBook Pros since 
2016.

Many people dislike the feel of the butterfly keyboard, with its minimal key travel, but the problem here is 
how much more susceptible they are to dust particles than those in previous Mac laptops, leading to more sticky 
and dead keys. AppleInsider recently calculated that the 2016 MacBook Pro butterfly keyboards fail twice as 
frequently as those in older models.

Combine that with a possible $700 charge for repair outside of warranty and AppleCare—since the keyboard 
is built into the MacBook and MacBook Pro bottom case and can’t be swapped out—and it’s little wonder that there is a lawsuit in progress (see 
“Class-Action Suit Filed against Apple for MacBook Butterfly Keyboards,” 16 May 2018).

You can get an affected laptop fixed at an Apple Store, an Apple Authorized Service Provider, or by sending it to Apple. Those who have already 
paid for a repair may be able to get a refund from Apple.

Note that your keyboard is covered for 4 years after your laptop’s initial purchase, and if your laptop has other damage that prevents a keyboard 
repair, that’s not included in the free service. If you purchased AppleCare coverage, this repair program extends coverage for just 1 year.

We’ve had mediocre results with MacBook keyboard reliability here at TidBITS. Agen Schmitz 
lost his H key earlier this week (he’s now known as Agen Scmitz) and is looking forward to a fix. 
Josh Centers suffered a stuck Tab key, though he fixed it by cleaning the space around the key with a 
toothpick. And my Space bar and Slash key started acting wonky a few months ago: subsequently, I 
had a great interaction with the local Apple Store. They did the ridiculously odd keyboard 
cleaning for me in an hour, supplementing the standard cleaning instructions with proprietary tools, 
and also cleaned my MacBook Pro’s exterior so it looked like it was fresh out of the box. I’ve had no 
trouble since, but granted, I shouldn’t have had any in the first place.

Even if the repair is free, it may still take a few days to get your MacBook or MacBook Pro fixed, 
so try a compressed-air cleaning first or an Apple Store visit if you have a similar early warning.

TipBITS: How to Recover Space from an iOS Update
by JOSH CENTERS

In the recent WWDC keynote, Apple highlighted how quickly many people upgraded to iOS 11 by 
claiming that half of the iOS user-base upgraded within 7 weeks. That sounds impressive, but as we all 
know, iOS is pretty pushy about updates—badging the Settings app icon and nagging you repeatedly to 
install the update. As part of that pushiness, if there’s sufficient free space on your device, iOS downloads 
its updates in the background so they’re available to install, regardless of whether you’re ready for them.

Therein lies the problem. Apple’s definition of “sufficient free space” may differ from yours, especially if you’re planning to shoot video of your 
kid’s soccer game and would rather use a few hundred megabytes for that instead of an update you don’t want to install yet.

Unfortunately, unlike in macOS, where you can avoid selecting the checkbox for “Download newly available updates in the background” in the 
App Store pane of System Preferences, iOS gives you no control over whether or not these updates are downloaded. Aside from the storage issue, that 

https://www.apple.com/support/keyboard-service-program-for-macbook-and-macbook-pro/
https://www.apple.com/support/keyboard-service-program-for-macbook-and-macbook-pro/
https://www.apple.com/support/keyboard-service-program-for-macbook-and-macbook-pro/
https://www.apple.com/support/keyboard-service-program-for-macbook-and-macbook-pro/
https://marco.org/2017/11/24/fixing-the-macbook-pro
https://marco.org/2017/11/24/fixing-the-macbook-pro
https://appleinsider.com/articles/18/04/30/2016-macbook-pro-butterfly-keyboards-failing-twice-as-frequently-as-older-models
https://appleinsider.com/articles/18/04/30/2016-macbook-pro-butterfly-keyboards-failing-twice-as-frequently-as-older-models
https://appleinsider.com/articles/18/04/30/2016-macbook-pro-butterfly-keyboards-failing-twice-as-frequently-as-older-models
https://appleinsider.com/articles/18/04/30/2016-macbook-pro-butterfly-keyboards-failing-twice-as-frequently-as-older-models
https://tidbits.com/2018/05/16/apples-growing-macbook-keyboard-headache/
https://tidbits.com/2018/05/16/apples-growing-macbook-keyboard-headache/
https://support.apple.com/en-us/ht205662
https://support.apple.com/en-us/ht205662
https://support.apple.com/en-us/ht205662
https://support.apple.com/en-us/ht205662
https://tidbits.com/uploads/2018/06/Air-cleaning-MacBook-Pro-keyboard.jpg
https://tidbits.com/uploads/2018/06/Air-cleaning-MacBook-Pro-keyboard.jpg
https://tidbits.com/uploads/2018/06/iOS-11-upgrade-time.jpg
https://tidbits.com/uploads/2018/06/iOS-11-upgrade-time.jpg
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lack of control might also present a bandwidth problem for 
people who are charged by the bit, who need to be careful 
of data caps, or who have very slow Internet connections 
and prefer to initiate such downloads when on a faster link. 
We presume that such updates download only over Wi-Fi, 
but again, Apple provides no transparency into the process.

If you do run into this situation, where you need to 
recover the space being consumed by an iOS update in 
waiting, you can do so, at least until iOS decides to 
download the update again.

First, to see if this is the case, tap Settings > General > 
Software Update. If the link at the bottom is Install Now, 
the update has already been downloaded and can be 
deleted. (If it instead reads Download and Install, the 
update hasn’t been downloaded automatically and thus isn’t 
taking any space.)

Next, go to Settings > General > iPhone/iPad Storage. 
This screen summarizes how your space is being used at the 
top, provides space-saving recommendations that are worth 
considering, and then lists each app in order of how much 
space it and its data take up. An iOS update might be 
relatively near the top if it’s a major update, such as from 
iOS 10 to iOS 11. Most updates within a major version are 
smaller, so you’ll need to scroll down in the list to find 
them. Tap the update, then tap Delete Update, and 
confirm that you want to delete it.

If you go back to Settings > General > Software Update, 
you’ll see that the link at the bottom has changed from 
Install Now to Download and Install. When you’re ready 
to install the update, tap that link to proceed.

Please don’t interpret this article as a suggestion that you 
should avoid installing updates. That’s a terrible idea. For 
stability and security reasons—not to mention getting new 
features—you should always install updates. But you can 
and should wait a few days after an update is released to 
make sure there aren’t any problems with it and then 
download at a time that works for you. The instructions 
above merely show you how you can manage your storage 
in the interim.

An iPhone with iOS 11.4 downloaded and ready to install (left) versus an iPad 
that hasn’t yet downloaded the update (right).

macOS Tips
How to Download all Your Apple Data

by KIRK MCELHEARN 

You have undoubtedly noticed by now that something called GDPR has taken effect (see “Europe’s General 
Data Protection Regulation Makes Privacy Global,” 2 May 2018). The General Data Protection Regulation is a 
European Union framework for handling user data. Even if you’re not in Europe, you have been receiving email 
messages regarding updated privacy policies. Many companies are applying GDPR’s requirements to their entire 
customer base under the assumption that it’s better and easier to homogenize the way they manage user data, 
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especially if other countries outside the EU adopt a similar approach to data management in the future. Plus it’s good publicity.

Apple is no exception to this movement. The company has changed the way it handles user data and the way it informs users about privacy. 
Because of this, it recently unveiled a new option that lets you download most of the data that is linked to your Apple ID. This feature is currently 
available to users in the European Union, as well as members of the European Single Market: Iceland, Liechtenstein, Norway, and Switzerland. 
Apple has said it will roll out this feature worldwide in the coming months.

To request your data, go to privacy.apple.com on a Mac or iPad (you can’t do this on an iPhone), sign in, answer the security questions that the 
Web site displays, and you’ll see four options:

• Get a copy of your data
• Correct your data
• Deactivate your account
• Delete your account
The second option isn’t particularly useful—it just provides links to the Apple ID Web site, where you can correct your name, address, and other 

data; and to Apple Online Store account settings. The last two options are somewhat self-explanatory: you can deactivate your account temporarily 
if you wish to take a break from Apple services (perhaps you want to delete your account but want to test the waters first to see if you’ll miss 
anything), or you can go nuclear and delete your account entirely.

The first option, however, is why we’re here.

Downloading Your Apple Data
To download your data, click the Get Started link at the end of the “Get a copy of your data” paragraph. It takes you to a page that explains what 

you can download and in which formats you’ll receive the data. Apple says this data will be provided “as spreadsheets or files in JSON, CSV, XML, 
or PDF format.” For many people, this choice will be confusing. Most people know what a PDF is, and many TidBITS readers probably know 
what a CSV file is, but how many will know what to do with an XML file or have even heard of a JSON file?

PDF is the most human-readable of these formats. CSV—comma-separated values—is basically a way of representing the columns and rows of 
spreadsheet data in a text file. XML and JSON are file formats that present data in a structured format, with tags, suitable for importing into other 
apps or uploading to Internet services.

You can download 15 types of data, as you can see in 
the screenshot. The page presents a series of categories: 
check those you want to download or click Select All.

The data does not include iTunes Store, App Store, or 
iBooks Store purchases, which are, for the most part, 
available for re-downloading from each store. (If you want 
to transfer your purchased movies away from iTunes, 
Movies Anywhere might help—see “Movies Anywhere 
Frees Your Films From Platform Lock-In,” 14 October 
2017.)

The organization of the data is a little odd and seems to 
be more by size than logic. The items in the top section 
either reflect your interactions with Apple or let you 
download small data stores: calendars, reminders, 
contacts, bookmarks, and notes. The bottom section 
provides access to larger data stores in iCloud: your files, 
email, and photos.

Although you can export all of the data out of the 
appropriate apps on your Mac, you may still want to 
download it if you’re moving away from Apple’s 
ecosystem and wish to import everything into another 
platform or service. Apple provides contacts, calendars, 
bookmarks, and email in (respectively) VCF, ICS, 
HTML, and EML formats, which are readily imported 
into other apps. The files, email, and photos in the 
bottom section are generally much larger downloads if 
you have a lot of files in your iCloud Drive or a lot of 
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photos. Apple warns that they may take a long time to retrieve.

When you’ve made your selection, click Continue, and you’ll be 
asked to select the maximum size of the files that Apple provides for 
download. Assuming you’ve only selected the first group of items, the 
total will probably be less than 1 GB. If you have a lot of photos, on the 
other hand, it could be hundreds of gigabytes, so choose a file size that’s 
easy for you to manage and download. If you have a slow Internet 
connection, specify smaller files, so if the download flakes out mid-file 
you won’t have to re-download too much data.

Apple says that it may take up to seven days to provide this data. For 
me, it took six days.

Six Days Later…
I requested my data on 23 May 2018, and on May 30th, I received 

an email from Apple telling me that I could download it.
I was taken to a Web page where I could download data from these 

twelve categories. Each category downloads as a Zip archive—a couple 
of which contained two or three more Zip archives. Most of the data is 
in CSV format, with a few JSON files. You can view the CSV files in 
the Finder with Quick Look (click a file and press the Space bar), or 
you can open them with Excel or Numbers to view them more easily.

None of the data is very interesting. It’s a lot of spreadsheets of things 
you’ve bought from Apple—even updates to iOS apps, your support 
history (such as repairs, online chats, and screen sharing sessions), 
information about which devices are signed into your Apple ID, and 
more.

It was interesting to see a list of all the repairs I’ve had to my Apple 
hardware. It’s worth noting that this is an Apple ID I’ve been using for 
just the five years that I’ve lived in the UK—but there isn’t much 
detail. In one file, I see the serial numbers of different devices and dates, 
but nothing about what type of devices they are or what type of repairs 
were carried out.

The majority of the data is store-related: devices authorised to use the 
iTunes Store, and apps, music, videos, and ebooks that I’ve purchased. 
But one thing that is missing is my purchases from the Apple online 
store: the two Macs I bought last year, my iPhone 8+ and previous 
iPhones, my Apple Watches, Apple TVs, and more. There is an Online Store Activity folder in the Other Activity folder, but its contents are sparse. 
It merely contains Ratings and Reviews, Saved 
Cart, and Shipping Address History.

There was one file I didn’t expect to see. In 
case you thought you could forget about this, 
there is a special file about that free U2 album 
that Apple gave everyone in 2014 (see“How to 
Get (or Delete) Your Free U2 Album,” 10 
September 2014). I don’t know what the file is 
for, other than as a reminder of that unpleasant 
incident.

It’s a good thing that Apple is providing a 
relatively simple way to access all this data, 
although some of the file formats may prove 
daunting for many users. To learn more, read 
Apple’s support document “Get a copy of the 
data associated with your Apple ID account,” 
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which includes a FAQ that deals with some of the questions that may arise, such as those concerning file formats, why some data is masked, why 
dates may seem strange, and more.

Many people, like me, will download this data out of curiosity. But this service is more about giving you a way to import your data into other apps 
or services because part of GDPR is the right to data portability, so you can move your data without losing anything. Think of it as an aid if you 
decide to leave the Apple ecosystem and want to be able to retain the data you’ve accumulated over time rather than a way of checking up on what 
data Apple has been storing about you.

macOS Hidden Treasures: Batch-Rename Items in the Finder
by SHARON ZARDETTO

When I was preparing inline graphics—the little images embedded in a line of text—for my Take Control of Numbers book, I was almost 
finished when I remembered that the filenames needed to adhere to a naming convention: they must end with _inline. Nearly 50 files needed 
renaming. A brief mental facepalm moment was followed by the relieved realization that the Finder could do it for me with its batch-rename 
capability.

You didn’t know the Finder has a batch-rename capability? That’s because the option is disguised as a seemingly useless Rename command in the 
File menu. After all, you can rename a file by clicking and typing. So, the Rename command has no reason to exist—until you’ve selected multiple 
items. Then, it changes to Rename [X] Items (identifying the number of selected items). But how would you know that since you aren’t likely to 
peruse menus after you’ve selected a bunch of files or folders?

And that’s how you start: select multiple items in any window view (including, if you need to, a mix of files and folders) and choose File > Rename 
[X] Items. (For the rest of this article, I’ll refer to the command as simply Rename Items.)

The Batch-Rename Triad
When you choose Rename Items for a selection, a dialog appears. (If 

you’re working in a window, it slides out from the title bar; if you’ve 
selected items on the desktop, you get a free-floating version.)

Its pop-up menu offers three options:
• Replace Text: Change any part of the existing filename to some 

other text. This option also lets you delete characters from filenames 
by replacing the existing text with nothing.

• Add Text: Add text before or after the filename.
• Format: Append an index or counter number (the latter uses leading zeros for a fixed number of digits) or the current date and time to the 

filename. You can place the number before or after the filename, replace the filename with different text, or obliterate the original name 
completely.

We’ll take a look at each of these options in action.

Replace or Delete Filename Text
How many files do you have whose names start with IMG_? Every time you dump images from your camera to your Mac, they’re named with 

that prefix, followed by a 4-digit number. Replace those leading characters with a descriptor so that you’ll know what’s what:
1. In the Finder window with the photo files, choose Edit > 

Select All, and then File > Rename Items.
2. Choose Replace Text from the dialog’s pop-up menu.
3. In the Find field, enter IMG_.
4. For Replace With, enter a description: Pool Party, 

Graduation, Disney World, or whatever. Be sure to include 
a trailing space or some other separator after the text. 
(Alternatively, set only IMG to be replaced, leaving the 
underscore.)

 If the example in the lower left of the dialog looks right, click 
Rename.

Have you ever wound up with a bunch of montly reports 
scattered among your monthly ones, or some similarly repeated 
typo? To replace montly with monthly:

1. Select the target files and choose File > Rename Items.
2. Choose Replace Text from the pop-up menu.
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https://www.takecontrolbooks.com/numbers?pt=TIDBITS
https://tidbits.com/uploads/2018/06/Replace-Text.jpg
https://tidbits.com/uploads/2018/06/Replace-Text.jpg


14
3. In the Find field, type montly; in Replace With, type 

monthly. Or, use shorter text replacement, such as 
substituting tly for thly as long as it wouldn’t interfere 
with other text in the filenames

You might be tempted to use the even briefer change of ly 
to hly; with that approach, however, if some of the files were 
correctly named to begin with, they would wind up with an 
extra h—monthhly. I recommend using full words to avoid 
problems that you might not notice while they’re still easily 
undo-able—although I confess this is a case of “Do as I say, 
not as I do.” If it’s too late to undo the mistake, it’s usually a 
cinch to do a second, more careful, batch rename to correct 
the issue. (Undo details are in the “Quick Tips” list at the 
end of this article.)

You can also use the Replace Text option to delete text 
from a filename: simply enter the delete target in Find, and 
leave Replace With blank. So, if you’ve decided that Monthly 
Report for January and its subsequent files are a tad 
redundant, set Find to monthly—making sure to include the trailing space—and leave Replace With empty.

There’s another example of deleting filename text ahead, under “Multiple-Pass Renaming.”

Add Text to Filenames
The Add text option in the Rename dialog lets 

you—you guessed it!—add text to the beginning or 
end of the filename: choose Add Text from the 
menu, type the additional text, and specify whether it 
goes before or after the name.

This is what I used to append _inline to my 
graphics, the issue I mentioned at the beginning of 
this article. You might find that you need to add a 
project name to a group of files, or that you forgot to 
append your initials to revisions of shared documents. 
Here’s how to make a simple adjustment like this:

1. Select the target files.
2. Choose File > Rename Items.
3. In the dialog, choose Add Text from the 
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pop-up menu, type the text, and choose Before Name 
or After Name from the second pop-up. 

4. Click Rename.
As you can see in the screenshot above, an “after name” 

addition ignores the file extension (.png) because it’s not 
considered part of the file’s name.

I frequently use this method to add leading zeroes to the 
beginning of single-digit numbers so I can more easily scan 
the then-even text in a list of numbered filenames. With just 
the single-digit files selected, I set the Rename option to Add 
Text, type a zero in the text field, and choose Before Name 
from the second menu.

Format Filenames with Numbers or Dates
The Format menu choice in the Rename dialog is not a 

shining example of nomenclature, for either its title or its contents. Your formatting options are:
• Name and Index: Adds consecutive numbers, starting at 1 or a number you specify.
• Name and Counter: Adds consecutive numbers, also starting at 1 or a specified number, but creates five-digit numbers by padding with leading 

zeroes where necessary: 00001 and 00237, for example.
• Name and Date: Adds the current date, as well as the time, down to the nearest second, in the format 2018-05-23 at 9.27.55 AM.
With each of these options, you can keep or replace the original 

filename, using the awkwardly named Custom Format field. Oddly, 
it usually starts with File as the default suggestion (without even the 
courtesy of a leading space, as you can see in the dialog’s Example line 
in this picture).

To replace the current filenames with a common name—so, for 
instance, only an index or counter number differentiates them (Field 
Test 1, Field Test 2)—enter that name in the Custom Format field. 
If you want the original name left intact, the Custom Format field 
must be blank, as shown in this picture.

It’s not immediately apparent how either of the numbering options 
is applied to selected files. Here’s the trick: when you’re working in a 
List view that has the names in the first column, as is nearly always the 
case, the numbers are applied, in order, to those names. No surprise 
there, but the controlling factor is actually the window’s sort order—
Dated Created, say, or Size—which, of course, affects the order of the 
names. So make sure to get your files in the right order before 
renaming them.

Multiple-Pass Renaming
Sometimes renaming requires more than one pass: altering the 

name, then adding a date, and finally deleting the timestamp that 
accompanies the date, for instance. But edits are simple to set up and 
take only seconds to run, so multiple passes are not time-consuming procedures.

Reword Filenames
If your files are named Monthly Report for [Month], and you’d prefer them to be [Month] Report, run them through the rename mill twice, first 

stripping Monthly Report for, and then adding Report to the end of the filenames:
1. Select the target files and choose File > Rename Items.
2. Choose Replace Text from the pop-up menu and type Monthly Report for (including a trailing space) in the Find field. Leave Replace With 

blank, and click Rename. The files are now named with only the month.
3. With the files still selected, choose File > Rename Items again. Choose Add Text from the pop-up menu and type Report in the text field; 

choose After Name from the second pop-up, and click Rename. 
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Strip the Time from Date & Time

I firmly believe that the application of a date stamp should be separate from a timestamp, but Apple failed to consult me on the matter. Luckily, 
it’s easy to strip out the time:

1. Get the exact wording of the timestamp portion of the 
renamed files by copying it from one of the filenames: select one 
of the files, activate its name by clicking it or pressing Return, and 
drag across the timestamp portion, including the “at” but leaving 
the leading or trailing space.

2. Select all the target files and choose File > Rename Items.
3. Choose Replace Text from the pop-up menu.
4. Paste the copied timestamp into the Find field, and 

leave the Replace With field blank.
5. Click Rename. 

Quick Tips
Here are a few more things you should know:
• Quick access to the Rename command: Tired of 

heading way up to the File menu for the Rename Items 
command? I have three solutions for you. Control-click 
any one of the selected files for a contextual menu that 
includes the Rename command, use the Action menu (the 

gear   icon) in the window’s toolbar, or… the third 
gets its own tip, next.

• Keyboard shortcut for the Rename command: If you use the Rename command frequently and are the type of person who prefers keyboard 
commands, then you’ll be disappointed when you realize that you can’t set up a keyboard shortcut for a command whose wording constantly 
changes (Rename 4 Items, Rename 12 Items…). Except that you can—in a roundabout sort of way: set up shortcuts for many different versions 
of the command and assign all of them the same shortcut. (Who knew? I didn’t, until I decided to try it for this because I prefer keyboard 
shortcuts for almost everything.) The method is no different from setting up other keyboard shortcuts:
1. Go to System Preferences > Keyboard > Shortcuts and click App Shortcuts in the app list.
2. Click the + button beneath the shortcut list and choose Finder from the pop-up menu in the dialog box. (If Finder is not in the shortcut list 

already, this procedure adds it; if it’s already listed, you 
still need to select it as the target.)

3. In the Menu Title field, type Rename 6 Items…. (You 
don’t have to use the ellipsis character—typed with 
Option-semicolon—you can simply type three 
periods.)

4. Go to the Keyboard Shortcut field and press the key 
combination you want to use.

5. Repeat this process for other numbers of files in the 
command name, using the same key combination.

I’ve found that System Preferences occasionally objects to the 
use of the same shortcut for multiple commands, but only 
mildly: sometimes not all the commands are listed correctly in its 
window, showing only an ellipsis (…) in place of the command 
name. But the shortcut keys remain displayed, the command 
names return on a subsequent opening of System Preferences, 
and all the shortcuts work in the meantime, so it’s only a minor 
glitch.

• Case insensitivity: In the Rename dialog box, the text you 
enter that is going to be replaced or erased is case 
insensitive—that is, upper- and lowercase letters are 
considered the same. But any replacement text will be used 
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exactly as you type it.

• Undo a rename mistake: Whether you inadvertently introduced a typo while renaming files, chose the wrong option (counters instead of serial 
numbers, say), or realized the renaming just isn’t what you want, you can use the Edit > Undo command to reverse the changes. If you change 
your mind about that, there’s Edit > Redo to the rescue. You can even go through several undo levels: if you added a serial number to the 
beginning of the file, and then a corrected project name to the end, you can undo each in turn to get back to the original filenames. Even if 
you’ve closed the window and opened others, you can go back to the folder of renamed files and undo the changes. There are some restrictions, 
of course, such as not having done anything undoable someplace else in the Finder.

ExtraBITS
macOS 10.14 Mojave Will Be the Last to Support 32-Bit Apps -- In news that won’t surprise attentive TidBITS readers, Apple has announced 
that the upcoming macOS 10.14 Mojave will be the last to support 32-bit apps. If you rely on older 32-bit apps, you probably have at least 15 
months before it becomes a problem in macOS 10.15.

Elgato Goes All-In on HomeKit; Changes Name to Eve Systems -- Hardware maker Elgato is going all-in on HomeKit home automation and 
to that end is changing its name and selling its gaming division.

Apple Releases Free Schoolwork App for Teachers -- Apple has released a new iPad app for teachers, dubbed Schoolwork, that aims to make it 
easy for teachers to manage assignments.

Apple Is Overhauling Maps -- If you thought that Apple Maps has been a joke since it debuted in 2012, you're not alone. Apple has spent the past 
four years rebuilding its mapping service.

Tim Cook on Joining Apple, Running for President, and More -- Financier David Rubenstein interviewed Apple CEO Tim Cook, and now 
the entire 24-minute conversation is available at Bloomberg. Or, if you’re short on time, you can read the highlights at 9to5Mac.

How Smartwatches Are Saving Lives -- Smartwatches like the Apple Watch are saving lives, but they’re not quite legitimate medical devices yet.

Craig Federighi Talks about Bringing iOS Apps to the Mac -- iOS apps are coming to the Mac. Apple’s Craig Federighi sat down with Wired to 
offer some specifics about how that will work.

Tim Cook Uses His iPhone Too Much -- During a CNN interview, Tim Cook made a surprising confession: the Screen Time feature in iOS 12 
made him realize that he uses his iPhone too much.

Sal Soghoian’s Automation Legacy -- Wired has published an entertaining profile of Sal Soghoian, the AppleScript and Automator guru who 
championed automation technology at Apple across three decades.

New EU Copyright Regulations Threaten the Internet
by JOSH CENTERS

The European Union’s legislative affairs committee has voted to include two potentially disastrous proposals in upcoming copyright reforms. 
Article 11 would prohibit linking to news stories without permission and a paid license, and Article 13 would mandate that all material posted by 
Europeans must first be evaluated by a copyright filter and blocked if it appeared to match a copyrighted 
work. Although these proposals aren’t yet law, Boing Boing’s Cory Doctorow worries they will pass 
with the upcoming copyright legislation unless Internet users in Europe can sway their lawmakers. Both 
articles would radically change how the Internet is used, and although they would technically apply only to 
Europeans, much like the GDPR, the end result could affect users worldwide (see “Europe’s General 
Data Protection Regulation Makes Privacy Global,” 2 May 2018).

•
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Reviews
Akvis AirBrush 6

by L. Davenport

Akvis AirBrush comes as a standalone program and/or plugin that can be use to convert your images into AirBrushed works of art. For those of 
you that are not familiar with airbrusing, it is a painting technique where an artist sprays color onto the canvas rather than brushing it on. This gives 
the finished artwork soft edges and a unique look. You have probably seen examples painted on the sides of “tricked-out” semi-trailers or on the 
occasional vintage car. 

Akvis AirBrush’s “Workspace” has a Before and After tab that lets you see 
if you are getting your desired results before applying it to your photo. 
AirBrush’s preferences let you change the Workplace’s interface between 
Light,  Gray, and Dark. Figure 1 is using the Gray theme whereas Figure 8  is 
using the Light theme, and Figure 10 is using the Dark theme.

Along the right side of the window is the Navigator window along with 
the Settings panel that contains parameter controls that you can use to 
modify your photo. These are divided into two tabs: Painting and 
Decoration. Let’s look into each tab to see what Akvis AirBrush can do.

Painting Tab
The Painting tab lets you control the Detail, Sharpness, Smudging, 

Shading, and Lightness of the AirBrush effect. If you create an effect that you 
like, you can save it as a new preset that you can re-use. But if you would 
rather not set it manually, you can use one of the 75 ready-to-use presets 
(Figure 4) that come with the program to modify your photo. These range 
from Black and white to color effects (BTW: the Original Colors mode, the 
Multicolor mode, and the Post-Processing tools are only available in the 
Home Deluxe and Business versions).

For the Home Deluxe and Business licenses of AirBrush - There is a 
“Smudge tool” that you can use to manually add smudges to different parts of 

Figure 2. You are not limited to using Akvis AirBrush on your photos. You can also use it on your 2D artwork or 3D renders. Above you can 
see the original 3D render on the left, the “Creme Burlee + Vignette” modified image at the center and a “Night Vision” version on the right.

Figure 1. AirBrush lets you preview the image changes 
either from within the “Dancing ants” selection box or by 
using the “Before” and “After” tabs.
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the images. There is also a “History Brush” that you can use to restore the image to its original state.
A “Smart Contrast” option adds extra highlights and shadows to your image thus making it more expressive.

Decoration Tab
The Decoration Tab has three sub-tabs:

• Text Tab: A painting isn’t complete until 
it has a signature or title. The Text tab lets 
you choose the font, font color, and 
location of your signature or title (bottom 
left corner, bottom right corner, etc.) - See 
Figure 5 for a text example.

You can also add a signature, Logo, or 
Watermark image to your photo.

• Canvas Tab: One of the ways to make 
your image look like it is a painting is to 
give it a canvas texture. AirBrush comes 
with 32 canvas textures - everything from 
fine to corse weaves. It also has cracked 
paint canvas’ that simulates the cracked 
look of very old paintings (Figure 10).

• Frame Tab: There are five different frame 
styles that you can add to your image: 

1. Classic: These are everything from 
Antique frames to frames made from 
Postage stamps and designs - See Figure 
8 for a list.

2. Pattern: Holiday themed designs, Stars, 
Ornaments, etc.

3. Strokes: Frames made from a group of 
strokes that surround the image. You 

Figure 3. I was able to use AirBrush to crop away the road, add the “Color Oil” preset, and 
add a frame around a photo that I took at Bryce Canyon.

Figure 5. The Default preset was used on this photo (which softened 
the people’s facial features, clothes, and the flower lei). An angled 
“Spray” was added (which makes the sky and their skin look like it 
was drawn from a lot of angled strokes) and a Title was added. I have 
also included a before and after closeup (on the right) which shows 
how the golden cape’s appearance/texture changed.

Figure 4. Here is a dropdown 
menu showing some of the 
AirBrush presets.
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can adjust the width of the frame as well as the width, length, and the number 
of the lines/Strokes.

4. Vignette: A Vignette darkens or lightens the edges of a picture which draws 
your eye to its center. It's perfect for creating retro styled images and portraits.

There are controls that you can use to set the Vignette’s Size, Shape, 
Darkness of the edges and the position of the Vignette on the image.

5. Passe-Partoout: This is the French term for a “Mat” which is usually a white 
or colored cardboard sheet with a center beveled cutout. FYI: Traditional 
mats are placed under the glass in a picture frame but on top of the painting 
or photo. It serves two purposes: to prevent the image from touching the 
(protective) glass, and for decoration. Akvis AirBrush can imitate this Matting 
effect - including the bevel and shadows.

  The beveled cutout can have sharp 45º angled corners (Figure 9), curved 
corners (curving either inward or 
outward), Chamfered, or Ledge corners.

Batch Processing
 If you have quite a few photos that 
you would like to add the same 
modifications/presets to, you can 
process them all at once using the 
Batch feature.

File Formats
 The Akvis AirBrush Standalone version is compatible with: RAW, 
JPEG, PNG, BMP, DNG, and TIFF file formats. Whereas the 
Akvis AirBrush plug-in can manipulate these file formats plus 
Photoshop PSD files (since it is used within the Photoshop or 
compatible program).

Akvis AirBrush versions:
 The Home version is divided into two separate items: a stand alone 
application and a plugin. The “Home Deluxe” and “Business” versions 
include both the application and the plug-in. 

Figure 6. AirBrush can be used to make interesting images, just like this Sim City style poster. If you would like to see how it was created, 
go to Akvis’ web site and read through its tutorial.

Figure 7. AirBrush can make eerie looking artwork

Figure 8. You can add frames to your image. The drop-down 
menu on the right shows some of the available frame types.

http://akvis.com/en/airbrush-tutorial/examples/poster-sin-city.php
http://akvis.com/en/airbrush-tutorial/examples/poster-sin-city.php


  The Home and 
H o m e D e l u x e 
versions are for 
non-commercial 
personal use whereas 
the Business version 
allows you to install 
the software on two computers and is for people/business who want to sell their final artwork. 
The final difference: The Home Deluxe and Business versions have a few extra tools whereas 
the Home version doesn't (as mentioned earlier). I suggest that you go to Akvis’ Comparison 
web page to see the exact difference between the different versions of AirBrush.

                     The Skinny
Evaluation: With all of the ready-to-use presets, it’s very easy to come up with interesting artwork. But if I had a wish list, I would like more 
positioning options so I can place the Titles in exactly the place that I want, e.g. for the Hawaii photo, I really wanted to lower the title a fraction, but 
I couldn’t figure out how to do that. It defaults to the extreme top/bottom/left/Right edges of the screen. But this is a minor thing and I can live with 
it this way.

Requires: macOS 10.7-10.13, 32 or 64 -bit; Minimal Hardware Requirements: 1 Gb RAM, 100 Mb HDD; Recommended Hardware 
Requirements: Intel Core i5, 4 Gb RAM, 2 Gb HDD; Video card compatible with DirectX 9+, 128 Mb, color depth 32 bit Intel, 4 Gb RAM, 2 
Gb HDD

Compatible Mac Photo Editors: AliveColors Free, Home, or Pro, Adobe Photoshop CC-CC 2018, Adobe Photoshop CS-CS6, Adobe 
Photoshop Elements 1-15, 2018

Company: Akvis

Price: Akvis Home (Standalone OR plugin): $49
          Akvis Home Deluxe (Standalone AND plugin): $69
          Akvis Buisness (Standalone AND plugin): $89
          Educational & Academic pricing: 30% off
          Bundle pricing is available

Available 10 day demo
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Figure 9. In addition to being able to add Frames to your 
images, you can also add beveled Mats (though if you want 
both a frame and a mat, you would have to do it in two 
steps). You can also specify the color of the mat and its bevel.

Figure 10. You can add a Canvas Texture to your image, 
thus making it look like your image was painted on a 
canvas. The image at the top left creates a cracked paint 
effect (as seen in the image below it). This texture is similar 
to the surfaces of very old paintings.

Figure 11. The Akvis web site has a tutorial 
that shows you how to use Akvis AirBrush to 
create an image that can be transferred to a 
T-shirt.

http://akvis.com/en/airbrush/comparison.php
http://akvis.com/en/airbrush/comparison.php
http://akvis.com/en/airbrush/index.php
http://akvis.com/en/airbrush/index.php
http://akvis.com/en/discounts.php
http://akvis.com/en/discounts.php
http://akvis.com/en/airbrush/download.php
http://akvis.com/en/airbrush/download.php
http://akvis.com/en/airbrush-tutorial/examples/creative-print.php
http://akvis.com/en/airbrush-tutorial/examples/creative-print.php
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UK Travel Tips: Giffgaff for Cellular and Apple Pay for Transit
by ADAM ENGST

We recently spent 10 days in the UK for a friend’s wedding, starting with a visit to longtime 
TidBITS and Take Control author Kirk McElhearn in Stratford-Upon-Avon (yes, we saw the 
Royal Shakespeare Company’s King Lear while there) and then moving on to London. It was a 
vacation studded with and improved by technology, including a public Qi-enabled charging station 
in the Newark airport, a rental VW Golf that gave us our first real-world experience with CarPlay 
(we immediately wanted iOS 12’s promised support for third-party navigation apps like Google 
Maps), and renting a large shared Airbnb apartment with other wedding-bound friends 
from Australia. We quickly set up a huge Messages conversation that included everyone 
we were with, complete with shared locations, and used it for coordinating five families 
through the visit.

Setting my iPhone X down on a charging pad in a public space was a little unnerving.
Two other bits of technology made the trip significantly easier and cheaper: Giffgaff 

and Apple Pay. The oddly named Giffgaff is a Mobile Virtual Network Operator, or 
MVNO, that uses the widespread O2 network in the UK and provides a useful way of 
getting inexpensive cellular data there. Apple Pay was helpful because it’s supported as a 
contactless payment system by Transport for London (TfL)—the authority overseeing 
the Tube, buses, London Overground, River Bus, and other forms of public 
transportation.

Giffgaff for Cellular
It’s almost hard to remember how we coped with travel in pre-iPhone days, what with paper maps, questionable guidebooks, fussy traveler’s 

checks, and inscrutable public transit systems. Internet services and iPhone apps have largely eliminated these problems, but for them to work, 
cellular data is necessary. I put some research into the best way of ensuring that our iPhones would be able to get Internet access as soon as we cleared 
customs.

One option was AT&T’s International Day Pass, which charges $10 per day and gives you unlimited calls and unlimited texts, and uses data 
from your existing plan. That might be fine for a day or two, but it would have cost us $300 for the three of us for the duration of the trip, and in 
retrospect, 3 GB wasn’t enough for the three of us anyway due to all the necessary mapping. Others recommended buying a SIM for a local carrier 
once we landed, but I disliked not knowing exactly where or how I’d do that, particularly while fuzzy after a red-eye flight. Ironically, I never saw a 
way of buying a SIM in the London Gatwick airport, but when we returned to the Newark airport in the US, we saw multiple SIM vending 
machines. And of course, if you have a carrier other than AT&T, the international options may be better.

Thanks, then, to TidBITS reader Jolin Warren, who 
suggested I use Giffgaff. Although Giffgaff is focused on 
providing service to UK residents, it has a service that works 
well for international visitors with unlocked iPhones. (Make 
sure to unlock your iPhone with your carrier well before you 
leave since it supposedly can take some time. AT&T’s 
unlocking process took just an hour or so for us.) You can 
order a SIM for free and receive it anywhere in the world. 
Then, before you leave for the UK, set up your Giffgaff 
account and purchase a “goodybag” that’s basically a bucket 
of minutes, texts, and data for a month.

We encountered some confusion, such as the activation 
page’s claim that a UK address was necessary and no way of knowing which of our credit cards would work in advance. Happily, no address was 
actually required, and I sidestepped the credit card issue by using PayPal. We were able to activate our SIMs and get our accounts working at home, 
and we even tested to make sure we could install the SIMs in our iPhones. I’d encourage you to do the same.

Travel
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The trickiest part turned out to be dealing with the SIMs themselves since 
they’re so tiny, and we had three that looked identical. We ended up marking 
them with a Sharpie to keep them straight and marking our original AT&T 
SIMs for when we returned. We ended up carrying the SIMs in a contact 
lens case, and I put the SIM extraction tool in my wallet. That was dumb 
since it disappeared under the car seat when I pulled out a credit card while 
getting gas on the way to the airport. Luckily, a paperclip worked and could 
be bent to fit in the other side of the lens case.
All that preparation was worthwhile since we were able to swap the SIMs as 
soon as we cleared customs, and that gave us full Internet access while picking 
up the rental car and navigating out of the airport.
One unexpected event was that our iPhones noticed the new phone numbers 
and asked repeatedly if we wanted to update our “trusted numbers,” 

eventually settling on one of those red-badged nags at the top of the 
Settings app. Apparently, a “trusted number” would be used if I 
needed to sign in from a new device, and since the chances and 
consequences of damaging an iPhone while traveling are both higher, 
it seemed like a worthwhile thing to do. Although we were initially 
hesitant to switch the numbers, as the middle screen below implied 
would be necessary, the screen on the right gave us the choice of using 
both numbers, which seemed sensible.

The only mistake we made was in underestimating how much data 
we’d need. At home, we share an AT&T family plan with 3 GB of 
data with no problems. So we each purchased a £7.50 goodybag that 
came with 1 GB of data, and each of us ran out before the end of the 
trip. Had we each purchased the £10 goodybag with 3 GB of data, we 
would have spent £30. Because you can only get more data before the 
end of a month by buying another goodybag and activating it early 
(once you have less than 50 MB of data remaining), we spent a total of £47.50 on the initial purchase plus extra data. At about $64, that was still 
way cheaper than AT&T’s $300.

Our error came in failing to realize that we’d be relying on our iPhones much more often throughout the day when we weren’t on Wi-Fi, as we 
are at home, and when Tristan is on the Cornell campus during the school year. Much of that data usage was due to non-stop mapping, but it’s 
worth going into Settings > Cellular and disabling access for any apps that you think might use a lot of data.

It’s also worth remembering that any services, like Twitter, that use SMS-based two-factor authentication, won’t be able to send you a text 
message to your new phone number. You may be able to work around that by signing in before you leave, or by switching to an authentication app 
like 1Password, Authy, Google Authenticator, or LastPass.

Apple Pay for Transit
The challenge of driving on the opposite side of the road was one thing when we were out on the motorways and around Stratford-Upon-Avon, 

but driving in London was insane, what with the traffic, squirrely little roads, trying to match Google Maps directions with difficult to find street 
signs, and more. We were happy to return our rental car right after arriving and planned to use 
London’s famed public transit system—the London Tube!—for the rest of the trip.

Relying on public transit systems as a tourist is often quite stressful, between the confusion of 
trying to figure out routes and figuring out the local payment systems and policies. Luckily, both 
Google Maps and Apple’s Maps did a good job of providing detailed directions that included 
walking routes when switching from a bus to the Tube, for instance. But payments were still a 
worry because there are all sorts of variables based on zones, time of day, age, and more.

The advice we’d been given by tech-savvy friends who had been to London recently was to 
just use Apple Pay. When you do that, TfL’s system tracks your usage throughout the day and 
charges you the lowest appropriate fare—taking into account daily caps that make the final 
amounts cheaper than day or week passes. (An alternative would have been to buy one of TfL’s 
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contactless Oyster cards, add money to it, and then get it refunded when we left the country. Our friends did that for their young children, who 
didn’t have iPhones. Also, we could have used contactless credit cards, which are still rare in the US, if we’d had them.)

The physical process of paying with Apple Pay is brilliant—most of the time. 
There’s a yellow payment pad on gates in the Tube stations and at the front of buses. 
You invoke Apple Pay, authenticate, and then touch your device to the pad. (You’re 
supposed to be able to touch your device to the pad to invoke Apple Pay and then 
authenticate, but that didn’t work the one time I tried it.) The gates then open, or a 
light turns green, indicating you can proceed. For the Tube, you have to touch in 
when you enter the station and touch out when you leave; for buses, you just touch in 
when you board and don’t need to touch out.

If you want to use Apple Pay for public transit in London, there are a few quirks to 
keep in mind:

• Use a supported credit card. Our debit cards from our local credit union had no 
currency conversion fees, so we thought we’d use them with Apple Pay. However, it turned out that US debit cards generally aren’t accepted in 
the UK, so we had to set Apple Pay to use a different credit card. Make sure you have a few credit cards loaded into Apple Pay to be safe.

• Use the same device each time. To avoid higher fares for seemingly incomplete journeys and to take advantage of the daily capping, you have 
to touch in and touch out with the same device for all your trips in a day. In other words, settle on your iPhone or your Apple Watch, and don’t 
switch. We only used our iPhones because I’ve had more trouble in general with Apple Pay payments registering from the Apple Watch. 
(Although I’m sad that I didn’t try it one day when we had little travel planned.)

• Be patient and try again if necessary. We had a non-trivial number of failures, where Tristan and I would get through the gates, for instance, 
but the system would reject Tonya’s payment. Some of that was user error, as we all figured out how to use Apple Pay more fluidly, but other 
failures had no obvious cause. It might have been related to all three of us using the same credit card in too quick succession, but sometimes 
everything worked as expected. Apart from suffering dirty looks from other commuters who we were blocking, there was no problem with 
waiting briefly or trying another gate—it always worked in the end.

Saunorch International Travel Power Adapter
Finally, as international travelers, we needed a plug adapter so we could charge our various devices with US plugs in UK sockets. There are many 

such devices, but I wanted to share the adapter I ended up buying since it worked extremely well.
The Saunorch International Travel Power Adapter is a 

colorful cube that combines a single universal AC socket with four 
USB charging ports that can be used simultaneously. It claims to 
have a smart IC chip that automatically recognizes devices to 
provide the right current output—I can’t speak to that, but all our 
devices (a collection of iPhones, iPads, Apple Watches, and a 
Garmin Forerunner 620) charged in what seemed like reasonable 
times.

The best part is that sliders on one side of the cube let you 
extend plugs for four different styles (US, UK, Europe, and 
Australia) to provide coverage for more than 150 countries. 
When not in use, they retract into the cube, making it easy to toss 
in a laptop bag without worrying about it poking anything. And 
it comes in bright green, which should make it less likely that it 
will be forgotten in a hotel room. (A bright blue model is similar, 
except for swapping one of the standard USB ports for a USB-C 
port.)

To protect your devices against power surges, Saunorch’s power 
adapter has a 6.3A fuse and comes with a spare fuse, although 
you’ll have to keep track of that separately. Note that it’s not a 
power converter, so it can’t convert voltage, though that doesn’t 
come up much with electronics. And it’s also not intended for 
high-power appliances like hair dryers or tea kettles. But for 
ensuring that you can charge your iPhone, MacBook, and other 
electronics wherever you are, it’s a steal at less than $20.
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TipBITS: How to Send a Full Web Page by Email
by ADAM ENGST

Overeager spam filters continue to obstruct the delivery of TidBITS issues—some content in last week’s issue 
caused Apple’s spam filters to delete it silently for many iCloud users (see “Macworld Tracks Down iCloud’s 
Silent Email Filtering,” 4 March 2013), and we heard from other users as well. I reported the problem to Apple, 
but if you were affected by this, I encourage you to complain to your ISP—your opinions as a customer carry 
greater weight than mine.

To the topic at hand, if you’ve missed an issue and want to get a copy into your email archive, here’s the trick. 
These steps work with any Web page in both macOS 10.13 High Sierra and iOS 11, and likely in older versions of Apple’s operating systems as 
well.

1. In Safari, while on any page on the TidBITS site, choose an issue from the 
Weekly Issues menu (on an iPhone, it’s accessible via the … button). You 
can also find all back issues on our Issues page.

2. To the right of the issue headline, click or tap Show Full Articles, which 
replaces the article summaries with the full text of each article. 

3. Depending on your operating system, follow one of these steps:
• (macOS; left) Click the Share button and choose Email This Page (or 
press Command-I).
• (iOS; right) Tap the Share button and then, in the Share sheet, tap the Mail 
button.

 In Mail, address the message to yourself and send it.
Mail on the Mac offers a few additional options. You can set the image size to small, 

medium, large, or actual size, and you can choose between the actual Web page and a 
Reader version that reformats the page in much the same way as Safari’s Reader mode. 
Other options include a PDF attachment and a link, but those won’t send the 
contents of the page in the body of an email message.

Reader and Web Page format the message quite differently, so experiment to see 
which you prefer. When testing, do actually send the messages to yourself since, 
disconcertingly, the outgoing message in Mail sometimes cuts off images on the right 
side, whereas the images appeared correctly when received. Either way, the issue won’t 
look exactly the same as it does when we send it, but all the content will be present.

What if you prefer to use another Web browser or email client? The number of 
possible combinations is too large for me to say for sure, but everything I tested sent just a link to the page, rather than the page contents. (If you do 
use another email client on the Mac, you’ll have to switch your default email client setting back to Mail in Mail’s preferences for this trick to work.) 
This is one case where Apple’s apps provide more functionality than the competition.

In my research, I also ran across the EmailThis service, which works by means of a bookmarklet or extensions to Chrome, Firefox, and Opera—
but it failed to send the full contents of the issue. Similarly, although the Instapaper service and app can theoretically send the full text a Web page 
via email, it lost portions of our issue pages in testing.

The Internet
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CE Week 2018: New Tech at “CES East”
by JEFF PORTEN

Every January brings the insanely huge CES, formerly known as the International 
Consumer Electronics Show—see this year’s coverage in our CES 2018 series. Halfway 
through the year, the Consumer Technology Association runs a much smaller East 
Coast show in New York City called “CE Week.” (It used to be an entire week; now it’s 
more like CE Thirty-Two Hour Roadtrip.) I attended the main show at the Javits 
Center, followed by a similar but unaffiliated show called PEPCOM Digital Experience 
held at the Metropolitan Pavilion elsewhere in NYC.

The usual disclosures: PEPCOM offers a pretty good buffet and an open bar to 
journalists who attend—I recommend the lemon mousse—which may lead to 
somewhat more upbeat coverage, so I always disclose. The gizmos below are in the order 
I saw them, with the PEPCOM entries starting with Monoprice and Anker. Anyone I 
cover who gave me anything more than a T-shirt—not necessarily the item I’m 

covering—is marked with a 🎁.

AirSelfie Camera Drone
I’m normally not interested in drones, but the AirSelfie caught my eye because it’s the size of a deck of cards 

and weighs less than that. I’m a sucker for gadgets I can throw into a pocket or backpack and forget about until I 
need them. The AirSelfie features a 1080p camera and 16 GB of unswappable onboard storage, and it sends a live 
feed to your iPhone (or Android smartphone), which you also use to steer. Your phone connects to the drone’s 
onboard Wi-Fi in order to control it, which limits the range to 65 feet (and takes your phone off any other Wi-Fi 
network you’re using). A 30-minute charge gets you 5 minutes of flight time that you start by tossing it flat up in 
the air. If the battery dies mid-flight, it’ll automatically descend, but it’s up to you to keep it out of a river or 
canyon. $199 or $249 with a Powerbank that recharges and doubles as a storage case. In theory, the drone is 
shipping now while the Powerbank is still to come; in practice, the AirSelfie is out of stock at the moment.

Udoq Multiple Device Dock
If your daily recharge dance involves plugging five gadgets into five cables, you might be interested in a 

Udoq. It’s an attractive and heavy metal shelf in varying sizes that can take up to five interchangeable inserts 
in the base that charge various devices with universal adapters. The iPhone X and Apple Watch each have 
an available mount that provides wireless Qi charging. The Udoq is slated to ship in December 2018—the 
CEO said everything was ready now except the iPhone X stand. The “Ultimate Apple bundle” is currently 
half off for $99 at Indiegogo, which includes two Lightning docks, the Qi iPhone X charger, and the 
Apple Watch charger stand.

myFlipShade

 In the “surprised no one’s thought of this before” category, myFlipShade 🎁 is a hinged plastic cover for your 
iPhone. Flipped down, it’s a screen protector. Flipped upwards, it’s a sunshade. Flip out the wings, it’s a privacy 
guard against sidelong glances. Flipped over, it’s a stand. It’s one size fits all for every iPhone from the 6 to the X 
(not the smaller iPhone SE), but the design is such that it’ll work with any phone in that size range so long as you 
don’t mind blocking your camera. Shipping now for $9.99, it’s also available at Target stores.

Pred Tokk Smart Assistant
If your reaction to the HomePod was, “that’s great, but I want one for my body,” the Tokk 

Smart Assistant might be up your alley. It’s a 2-inch round speaker/mic combination that clips 
magnetically to your shirt collar or neckline with a button for activating Siri, and useful in 
situations when you don’t want buds in your ears. $49.99, available in black, red, and white.

2018 Computer Electronic Show
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Monoprice True Wireless and Anker Liberty Lite Bluetooth Earbuds

Since the debut of the AirPods, I’ve grown a bit jaded about the number of nearly identical 
wireless earbuds I’ve seen at CES—which is why when the Monoprice rep told me their True 
Wireless earbuds sold for $50, I made the poor woman repeat herself three times to make 
sure she wasn’t saying $150. Then Anker told me about their Liberty Lite model for $70, so I 
guess sub-$100 is now a thing. (A search on Amazon reveals other models in this price range 
from companies I’ve never heard of.) Otherwise, both are what you’d expect: Bluetooth 
earbuds with 2.5 hours (Monoprice) or 3.5 hours (Anker) listening time, with a carrying case 
doubling as a charger. Monoprice is shipping now (pictured); Anker is coming out in mid-July. (Googling for the Anker earbuds now takes you to a 
similarly-named older model priced at $100.)

Neurovalens Modius Weight Loss Headset
“Revolutionary” e-health gadgets are a dime a dozen at CES, and I have a healthy 

exaggeration detector to filter such claims before they get to you. My detector was pinging 
madly while discussing the Modius headset with the PR rep, who claimed “self-reported” 
weight loss from their users when combined with diet and exercise—to which I replied that 
anything is effective for weight loss with enough diet and exercise. But after talking to their 
CEO, it could be the real deal. (That link is unrelated to research done by the 
company.) [Editor’s Note: In fact, that link goes to an abstract for a poster presentation given by the 
founder of Modius.] Apparently, the headset works by stimulating your vestibular nerves while 
you exercise, which somehow retrains your brain so you get a similar metabolism to people 
who are naturally lean. They currently have hush-hush clinical trials underway—they won’t 
reveal with whom, apparently because they’re not allowed to—and the CEO came right out 
and said that they’re selling now because brain-stimulant headsets aren’t regulated by the 
FDA. So if you don’t want to wait for proof it works—or a review I might do someday, as I 
could stand to lose a pound (or thirty)—the Modius headset is available now for $499.

Cortica AI
On the other hand, my exaggeration detector remains in high dudgeon over the claims of Cortica, an Israeli AI research company. I’ll quote their 

press release: “Cortica’s technology enables machines to mimic human level cognitive function outside the confines of the brain. This AI liberates 
machines from the confines of their programming allowing them to grow and learn on their own in the way that people do.” They claim to have 
done this with extensive research into the mammalian cortex, which I buy, but as for the results? We’re not there yet. Maybe I’ll end up eating these 
words with a light vinaigrette; if I do, Cortica’s first push is to have their artificial ferret brains driving your cars.

ThinOptics Reading Glasses

I’ve written before about the ThinOptics line of reading glasses 🎁. Most of these have 
unbreakable rubber frames that attach to the bridge of your nose and fold up into a slim carrying 
case suitable for attaching to the back of your phone or on a keychain. But keep an eye out—
hopefully at a middle distance that’s not blurry for you—for their upcoming Frontpage Collection 
model that manages to get glasses with ear stems into a case the width of a few credit cards: 1.3 
ounces total in the case, and 0.3 ounces on your face. They come in various styles and will be 
available after 9 July 2018 for $49. Their other models are in the $20–$30 range. Lens strengths 
start at +1.0, which unfortunately doesn’t do much good for my 48-year-old eyes that need a 
+0.5.

Rocketbook Everlast Mini

I loved the idea of the Rocketbook 🎁 at CES last January (see “CES 2018: ShowStoppers 
Prepares for the Collapse of Civilization,” 12 January 2018): a reusable paper notebook with 
icons at the bottom of every page, and an app that routes pictures of those pages to various cloud 
services based on which icons you mark. But I haven’t yet taken my promotional freebie out of 
its packaging since January, as I never need a full-sized notebook. Enter the Everlast Mini, a 
handheld notebook from the company based on the same idea. Unlike other Rocketbooks that 
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are erasable with a dry-erase cloth (or, weirdly, by putting the whole thing in a microwave), the Everlast Mini uses a damp cloth—so don’t let it get 
caught in the rain. It ships with the Pilot Frixion pen necessary to make the ink erasable, but works with any pen in that line. Available at 
Indiegogo starting at $16, shipping in July 2018.

Republic Wireless Relay
You want your kids to have a phone so you can reach them or find them, but you don’t want them to 

stare at a screen all day or break something expensive. Consider a Relay, a ruggedized plastic one-button 
speaker/mic combination with the guts of a cell phone but no screen. A press of the button activates a 
walkie-talkie or sends a voice message to you (in an iPhone or Android app) or other paired Relays. 
Meanwhile, you can track your kids with GPS, and yell through the speaker that playtime is over. The 
Relay works with Wi-Fi or Republic Wireless 4G (which, in turn, relies on T-Mobile and Sprint 
networks). There may not be a distracting screen, but Republic Wireless promises music, audio-based 
games, and upcoming access to Google Assistant. Available in packs of one, two, or three for $99, $149, and $199 respectively (you only need one 
per kid if you’re using the app); each Relay requires a $7/month all-you-can-eat service plan.

Chefling Kitchen Assistant App
Chefling is a great idea that 

makes me a bit nervous. It’s a 
free app, currently available for 
iOS or Android, which you use 
to scan either the barcodes on 
your groceries or your entire 
receipt. It can then track what 
ingredients you use and what 
you have left, and suggest 
recipes to use it in time. Great so 
far. But when I asked how the 
company intends to make 
money, they said “user data.” 
Due to a bit of PR rep 
hesitation, I didn’t quite buy 
their assurances that they meant 
aggregate data and not what 
you, personally, are putting on 
your dining room table. Sure, 
it’s not a great deal more 
invasive than what any store 
with a loyalty card has on your 
buying habits—except Chefling 
will know about all your 
groceries from any store. I’ll give 
it a try, because I’m an idiot in 
the kitchen and I don’t care 
much about this data getting 
out—but you should make that 
decision for yourself before you 
fire it up.
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.



30

Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($30) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $30.00  APR 1 to JUN 30 - $20.00
 JUL 1 to SEPT 30 - $15.00  OCT 1 to DEC 31 - $10.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc.    
2100 Wood Avenue
Colorado Springs, CO 80907-6718 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.
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